Intuit® QuickBooks®
Enterprise Solutions

Installation and Setup Guide
Copyright

Copyright © 2009 Intuit Inc.
All rights reserved.
First printing, September 2008

STATEMENTS IN THIS DOCUMENT REGARDING THIRD-PARTY STANDARDS OR SOFTWARE ARE BASED ON INFORMATION MADE AVAILABLE BY THIRD PARTIES. INTUIT AND ITS AFFILIATES ARE NOT THE SOURCE OF SUCH INFORMATION AND HAVE NOT INDEPENDENTLY VERIFIED SUCH INFORMATION. THE INFORMATION IN THIS DOCUMENT IS SUBJECT TO CHANGE WITHOUT NOTICE.

Trademarks and Patents

Intuit, the Intuit logo, QuickBooks, QuickBase, Quicken, TurboTax, ProSeries, Lacerte, EasyStep, and QuickZoom, among others, are registered trademarks and/or registered service marks of Intuit Inc. in the United States and other countries. Other parties’ trademarks or service marks are the property of their respective owners and should be treated as such. Features and services within QuickBooks products may be the subject matter of pending and issued U.S. patents assigned to Intuit Inc.

Other Attributions

The Regex Library contained in QuickBooks software is copyright 1992, 1993, 1994, 1997 Henry Spencer. All rights reserved. The Regex Library software is not subject to any license of the American Telephone and Telegraph Company or of the Regents of the University of California.

This product includes software developed by the Apache Software Foundation (www.apache.org). © 1999-2006 Apache Software Foundation. All rights reserved.

Important

Terms, conditions, features, service offerings, prices, and hours referenced in this document are subject to change without notice. We at Intuit are committed to bringing you great online services through QuickBooks. Occasionally, we may decide to update our selection and change our service offerings, so please check www.quickbooks.com for the latest information, including pricing and availability, on our products and services.
# Contents

## Welcome

- Audience of This Guide ................................................................. 5
- Technical Support ................................................................. 6

## Chapter 1. Installation Summary

- Part 1: Preparation .............................................................................. 7
- Part 2: Installation ............................................................................. 8
- Part 3: Setup ................................................................................... 9

## Chapter 2. Preparing to Install Enterprise Solutions

- Understanding Your Enterprise Solutions Environment .................. 11
  - Enterprise Solutions Configurations ............................................. 11
  - Installation Options ....................................................................... 12
- System Requirements ....................................................................... 15
- Firewall and Antivirus Software Compatibility ............................... 16
- Network Configuration ..................................................................... 17
  - Network Requirements ................................................................... 17
  - Testing Your Network Bandwidth ................................................... 18
  - Improving Performance ............................................................... 19
- Backing Up Your Previous Accounting System .............................. 19
Chapter 3. Installing Enterprise Solutions

Installing Enterprise Solutions Software ........................................... 21
Configuring Database Server Manager ............................................. 23
Scanning Company Files ................................................................. 24
Monitoring Your Hard Drives ......................................................... 25
Providing Access to Company Files ............................................... 25
Registering Your Enterprise Solutions Software ............................. 26
Installing Additional Software ......................................................... 27

Chapter 4. Setting Up Enterprise Solutions

Creating a Company File ................................................................. 29
Completing Your Company File Setup ........................................... 34
Enter Your Company Information ............................................... 34
Review Your Chart of Accounts .................................................... 34
Number Your Accounts ............................................................... 35
Create Your Customer, Vendor, and Item Lists ............................... 35
Enter Historical Transactions ....................................................... 36
Complete Your Bank Account Information .................................... 37
Synchronize with Microsoft Outlook .............................................. 37
Enter Any Optional Adjustments .................................................. 38
Updating Your Company File ......................................................... 39
Adding and Setting Up Users ......................................................... 40
Setting Up Multi-User Hosting ....................................................... 41
Converting Data from Other Applications ..................................... 42
Updating Your Enterprise Solutions Software ........................................ 43

Appendix A. Troubleshooting and FAQs

Troubleshooting .................................................................................. 45
  If you have trouble installing Enterprise Solutions: .......................... 45
  If you cannot find your Registration Number: .................................... 45
  If you cannot find your License Number or Product Number: .......... 46
  If old administrator password does not work after upgrading: .......... 46
  If a problem occurs when updating your company file: .................... 47
  If you do not have Internet Explorer on your computer: .................. 48

Frequently Asked Questions ................................................................. 49
  How do I contact Technical Support? .................................................. 49
  How do I purchase additional user licenses? ...................................... 49
  How do I download and install an update or patch? ......................... 49
  How do I move my company file from one computer to another? ........ 50
  How do I back up or restore my company file? ................................. 51
  Can I install different versions of Enterprise Solutions? ..................... 51
  How do I revert to an earlier version of Enterprise Solutions? .......... 51
  How do I install an Enterprise Solutions upgrade CD? ..................... 52

Index
Welcome

Welcome to Intuit QuickBooks Enterprise Solutions Financial Software. Use this guide to install and set up QuickBooks Enterprise Solutions.

To learn how to use Enterprise Solutions and perform essential tasks, refer to the *QuickBooks Enterprise Solutions User Guide*.

**Audience of This Guide**

The *QuickBooks Enterprise Solutions Installation and Setup Guide* has been prepared for two types of users:

- A system administrator who understands network operations and has permissions to properly install and configure the Enterprise Solutions software. Read Preparing to Install Enterprise Solutions on page 11 and Installing Enterprise Solutions on page 21.

- A CFO, CPA, or financial professional who understands the company’s financial needs and has sufficient knowledge to set up a company file and determine which users can access the company file to perform their daily tasks. Read Setting Up Enterprise Solutions on page 29.
Technical Support

Visit our Support website at www.qbes.com/support for support options and answers to frequently asked questions. Enterprise Solutions offers a Full Service Plan¹ (sold separately) that includes product upgrades, technical support, training tools, and data protection services. Intuit reserves the right to limit each telephone contact to one hour and to one incident. Additional terms and conditions apply.

You can also visit the QuickBooks Enterprise Solutions User Community at www.qbes.com/community to connect with other Enterprise Solutions users and experts to ask questions and share advice.

¹. The Full Service Plan is good for 12 months from your QuickBooks Enterprise Solutions purchase date or Full Service Plan renewal date. The Intuit support team is available weekdays from 4 A.M. - 7 P.M. Pacific time. Intuit reserves the right to limit each telephone contact to one hour and to one incident. Support availability subject to occasional downtime for systems and server maintenance, company events, observed U.S. holidays, and events beyond our control. Terms, conditions, pricing, service offerings, and availability of the Full Service Plan are subject to change at any time without notice. U.S. only. See terms and conditions at www.qbes.com/terms.
Installation Summary

This chapter summarizes the steps involved in installing and setting up Enterprise Solutions.

Part 1: Preparation

1. Determine how you want to set up your Enterprise Solutions environment. Read Understanding Your Enterprise Solutions Environment on page 11.

2. Verify the system requirements listed in System Requirements on page 15.

3. Verify that the computers on which you plan to install Enterprise Solutions are properly networked. Read Network Configuration on page 17.

4. If you have an existing business, back up your previous accounting system. Read Backing Up Your Previous Accounting System on page 19.
Part 2: Installation

1. Install the Enterprise Solutions software on your computers as described in Installing Enterprise Solutions Software on page 21.

   To install Enterprise Solutions on a Linux server, refer to the QuickBooks Enterprise Solutions Linux Database Manager Installation and Configuration Guide, located in the LinuxDBServer directory on the QuickBooks Enterprise Solutions CD-ROM. You can also download the guide from www.qbes.com/linux.

   For information about installing Enterprise Solutions on your client computers, refer to Installing Enterprise Solutions Software on page 21 of this Guide. Enterprise Solutions is supported on Windows clients only.

2. If you install Enterprise Solutions on a server, launch the QuickBooks Database Server Manager after installation is complete. Use this tool to configure the database server. Read Configuring Database Server Manager on page 23.

3. Register your copy of Enterprise Solutions on your computers as described in Registering Your Enterprise Solutions Software on page 26.

4. Share the folder that contains your QuickBooks company files across your network. Refer to the documentation for your operating system to learn about sharing folders.

5. Install any additional software that is compatible with Enterprise Solutions on your computers. Read Installing Additional Software on page 27.
Part 3: Setup

1. Set up your company file:
   - If you are installing Enterprise Solutions for the first time, create your company file. Read Creating a Company File on page 29.
   - If you are upgrading from a previous version of Enterprise Solutions, or from a different version of QuickBooks (Pro or Premier), update your company file. Read Updating Your Company File on page 39.

2. Add and configure the users that are allowed to access the company file. Read Adding and Setting Up Users on page 40.

3. Turn on multi-user hosting on your server. Read Setting Up Multi-User Hosting on page 41.

4. Convert data from other applications (if applicable). Read Converting Data from Other Applications on page 42.
Preparing to Install Enterprise Solutions

Read the following information to determine what you need to know before you start to install and configure Enterprise Solutions.

Understanding Your Enterprise Solutions Environment

Read this section to determine what type of network environment you have and how you can set up your Enterprise Solutions environment.

Enterprise Solutions Configurations

To enable multiple users to work on Enterprise Solutions at the same time, a dedicated computer must run the Enterprise Solutions Database Server Manager and store the company file. This computer is called a server and is either a dedicated file server in a client/server network, a dedicated computer in a network hosting environment, or a terminal server in a terminal server network.

In a client/server configuration, the file server contains the Enterprise Solutions Database Server Manager components and stores the company file that other users access but no one runs the Enterprise Solutions application on this computer. The Enterprise Solutions application must be installed on every user’s computer (a client) so that they can perform Enterprise Solutions operations and request data from the file server. The Enterprise Solutions Database Server Manager components must be installed on the file server.

In a network hosting configuration, each computer has its own full version of Enterprise Solutions installed; however, the company file is located on only one computer (the network host), which must be turned on and available on the network. Networks set up for hosting files do not use a
dedicated file server, so a single, dedicated computer is not required to share files. All the networked computers have the option to share their resources.

In a terminal server configuration, the terminal server contains the Enterprise Solutions database components, stores the company file, and runs the Enterprise Solutions application. The terminal users have access to the Enterprise Solutions application on the terminal server.

Installation Options

During software installation, the Custom and Network options path provides three different choices:

- **I’ll be using QuickBooks on this computer:** You use QuickBooks on this computer and this computer DOES NOT share company files with other computers. (This can be changed later.)

- **I’ll be using QuickBooks on this computer, AND I’ll be storing our company file here so it can be shared over our network:** You use QuickBooks on this computer and this computer DOES share company files so other users on the network can open them. (This can be changed later.)

- **I will NOT be using QuickBooks on this computer. I’ll be storing our company file here so it can be shared over our network:**
No one uses QuickBooks on this computer and it only stores company files that other users open across the network. This will install the QuickBooks Database Manager only and does not require a license.

To help you choose, consider the following examples for a small business with an owner and a bookkeeper:

**Figure 1  Database Server and QuickBooks Application**

In Figure 1, the bookkeeper is the primary user on **Computer 1**, which stores the company file (the server). The owner on **Computer 2** (client) uses Enterprise Solutions to run and look at reports. The owner can directly open the company file on the bookkeeper’s machine (**Computer 1**) because the computers are networked. If the bookkeeper turns off **Computer 1**, the owner can no longer open the company file.

**Figure 2  Database Server Only**

In Figure 2, a file server stores the company file. The file server is always on and no one uses the server except to do maintenance. Both the owner on **Computer 2** (client) and the bookkeeper on **Computer 1** (client) can open
the company file. If the bookkeeper turns off Computer 1, the owner can still open the company file because it is stored on the file server.

Table 1 provides a summary of the installation options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Components</th>
<th>Install on...</th>
<th>Requires Licence and Registration?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>QuickBooks Enterprise Solutions application</td>
<td>All client computers that run Enterprise Solutions but access company files located on a file server or network host</td>
<td>Yes</td>
</tr>
<tr>
<td>Server: Database Server Only</td>
<td>Database components</td>
<td>A Windows file server</td>
<td>No</td>
</tr>
<tr>
<td>Server: Database Server and QuickBooks Application</td>
<td>Database components and QuickBooks Enterprise Solutions application</td>
<td>A network host A terminal server</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 1 Installation Option Summary

Note

For full instructions on installing Enterprise Solutions on a terminal server, refer to the QuickBooks Support Knowledgebase at www.qbes.com/support.

For instructions on installing Enterprise Solutions on a Linux server, refer to the QuickBooks Enterprise Solutions Linux Database Server Manager Installation and Configuration Guide, located in the LinuxDBServer directory on the QuickBooks Enterprise Solutions CD-ROM. You can also download the guide from www.qbes.com/linux.
# System Requirements

The following table provides the hardware and software requirements for installing Enterprise Solutions. See [www.qbes.com/systemrequirements](http://www.qbes.com/systemrequirements) for the most current system requirements.

<table>
<thead>
<tr>
<th>Hardware and Software</th>
<th>Minimum Requirements</th>
</tr>
</thead>
</table>
| Processor             | **Server**: 2.8 GHz Pentium 4  
                        | **Client**: 2.0 GHz Pentium 4 (Windows XP)  
                        | 2.8 GHz Pentium 4 (Windows 7 or Vista) |
| RAM                   | **Server**: 1 GB (+ additional space for company files)  
                        | **Client**: 512 MB (Windows XP)  
                        | 1GB (Windows 7 or Vista) |
| Disk Space            | **Server**: 1 GB  
                        | **Client**: 1 GB |
| 4x CD-ROM Drive       | Required |
| Monitor               | Optimized for 1024x768 screen resolution or higher. 1024x768 or higher is required. |

**Operating Systems Supported (U.S. versions with Regional Language set to U.S. English recommended)**

- Windows 7, all editions except Starter and Basic
- Windows XP (SP2 or later strongly recommended), all editions
- Windows Vista (w/UAC on), all editions
- Windows Server 2003
- Windows Server 2008

64-bit version of above operating systems also supported

**Disk Space Requirements for Additional Software**

<table>
<thead>
<tr>
<th>Software</th>
<th>Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft .NET 3.5 Runtime</td>
<td>232 MB</td>
</tr>
<tr>
<td></td>
<td>Provided on the QuickBooks CD</td>
</tr>
<tr>
<td>Google Desktop Search</td>
<td>1GB</td>
</tr>
</tbody>
</table>

*Table 2  System Requirements*
Intuit recommends that you do not install Enterprise Solutions on a terminal server that is a communications server, print server, or modem server.

System requirements for a Linux server are described in the QuickBooks Enterprise Solutions Linux Database Server Manager Installation and Configuration Guide, located in the LinuxDBServer directory on the QuickBooks Enterprise Solutions CD-ROM. You can also download the Guide from www.qbes.com/linux.

Firewall and Antivirus Software Compatibility

Enterprise Solutions has been tested with the following firewall and antivirus products:

- Microsoft® Windows XP Firewall (all editions)
- Microsoft® Windows Vista Firewall (all editions)
- Microsoft® Windows 7 Firewall (all editions)
- Symantec Norton® AntiVirus, Internet Security Suite, Norton 360
- Microsoft® OneCare
- McAfee Anti-Virus Plus, Internet Security Suite, Total Protection
- Trend PC-Cillin, Internet Security
- Zone Labs ZoneAlarm

Some configurations may require that you adjust settings in these firewall and antivirus products to ensure the best possible performance with Enterprise Solutions.

If firewall software is running when you install Enterprise Solutions, a prompt asks you if you want to allow Enterprise Solutions components to have access to the network. For Enterprise Solutions to operate correctly, certain components, such as FileManagement.exe, QBDBMgrN.exe, QBGDSPlugin.exe, and QBW32.exe must be able to access the network.

For more information about firewall configuration, search for firewall settings in the in-product Help.
Network Configuration

Enterprise Solutions allows multiple users to access company files on a network at the same time. To achieve the best performance:

- Make sure that your computers are networked properly. Refer to your networking software documentation for instructions.
- Make sure that your network meets the requirements specified in Network Requirements, below.
- Make sure that your network connection is working fast enough to run Enterprise Solutions. Refer to Testing Your Network Bandwidth on page 18.
- Avoid accessing your company file from a computer that uses a hub, network bridge, or wireless network; they may affect the performance and reliability of Enterprise Solutions.
- Configure your firewalls so that they do not interfere with Enterprise Solutions. An incorrectly-configured firewall can stop Enterprise Solutions from working. Refer to Firewall and Antivirus Software Compatibility on page 16.

Network Requirements

The following table provides the network requirements for Enterprise Solutions:

<table>
<thead>
<tr>
<th>Network</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Card</td>
<td>100 Mbps</td>
</tr>
<tr>
<td>Switch or Router</td>
<td>100 Mbps</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>40 Mbps</td>
</tr>
</tbody>
</table>

To test your network bandwidth, refer to Testing Your Network Bandwidth on page 18.

Table 3 Network Requirements
Testing Your Network Bandwidth

To make sure that your network connection is working fast enough to run Enterprise Solutions, perform the following procedure on each computer where you intend to install Enterprise Solutions.

- **To test your network bandwidth:**
  1. Choose a large data file with which to perform the network bandwidth test.
     
     **Important:** If you are upgrading from a previous version of QuickBooks Enterprise Solutions, Premier, or Pro do not use a company file (.qbw) for your test; otherwise other users will not be able to continue their work until you complete the network bandwidth test.
  2. Note the size of your test file in megabytes.
  3. Copy your test file from a network location to the computer and make a note of the amount of time (in seconds) it takes to copy.
  4. Perform the following calculation to determine the network bandwidth:
     
     file size *8 /copy time
     
     For example 150 MB *8 /25 seconds = 48 Mbps

If your network bandwidth is 40 Mbps or more, the network connection is configured for optimum Enterprise Solutions performance. If your network bandwidth is less than 40 Mbps, your network connection is not working fast enough to run Enterprise Solutions.
Improving Performance

To improve Enterprise Solutions performance, consider these tips:

- Store company files on the fastest or most powerful computer, preferably a dedicated file server.
- Run reports during off hours.
- Refresh reports only when you are ready to use or print them.
- Avoid keeping unnecessary Enterprise Solutions windows or other applications open.

Backing Up Your Previous Accounting System

If you have an existing business, make sure that you back up your financial records from your previous accounting system before you proceed with installation. The IRS requires that you keep this information for 10 years. You should also keep any software and hardware that your previous accounting system used, or have printouts of all the information and accounting reports.
Install the Enterprise Solutions Financial Software on your computers only after you have read Chapter 2, Preparing to Install Enterprise Solutions on page 11.

Install the same version of Enterprise Solutions on all computers. For example, all users must have QuickBooks Enterprise Solutions 10.0.

If you previously installed Enterprise Solutions from a trial CD, download, or some other mechanism, you might have chosen to receive a Reinstall Pack. The Reinstall Pack includes a QuickBooks Enterprise Solutions CD and this documentation. You do not need to reinstall Enterprise Solutions unless you are moving Enterprise Solutions to another computer or replacing the installation on your current computer. Keep the reinstallation disk as a backup for later use.

Installing Enterprise Solutions Software

Follow the procedure below to install Enterprise Solutions on each computer.

If you are running a previous version of Enterprise Solutions, Intuit recommends creating a backup of your company file using the Save copy or Backup command in your current version. Refer to Updating Your Company File on page 39 for more information.

• Close all running programs, including virus protection programs.

1. Insert the Enterprise Solutions CD-ROM in your computer's CD-ROM drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar and then click Run. Type D:\setup.exe (where D is the CD-ROM drive letter). Click OK.
Install the Enterprise Solutions Financial Software on your computers only after you have read Chapter 2, Preparing to Install Enterprise Solutions on page 11.

**Important**
Install the same version of Enterprise Solutions on all computers. For example, all users must have QuickBooks Enterprise Solutions 10.0.

**Note**
If you previously installed Enterprise Solutions from a trial CD, download, or some other mechanism, you might have chosen to receive a Reinstall Pack. The Reinstall Pack includes a QuickBooks Enterprise Solutions CD and this documentation. You do not need to reinstall Enterprise Solutions unless you are moving Enterprise Solutions to another computer or replacing the installation on your current computer. Keep the reinstallation disk as a backup for later use.

### Installing Enterprise Solutions Software

Follow the procedure below to install Enterprise Solutions on each computer.

**Important**
If you are running a previous version of Enterprise Solutions, Intuit recommends creating a backup of your company file using the **Save copy or Backup** command in your current version. Refer to **Updating Your Company File** on page 39 for more information.

- **To install the Enterprise Solutions software:**
  1. Close all running programs, including virus protection programs.
  2. Insert the Enterprise Solutions CD-ROM in your computer’s CD-ROM drive.

  **Note:** If the Installation Wizard does not start automatically, click **Start** in the taskbar and then click **Run**. Type `D:\setup.exe` (where `D` is the CD-ROM drive letter). Click **OK**.
3. In the Welcome window, click **Next**.

4. Read the licence agreements. If you agree to the terms, click **I accept the terms of the licence agreements** and click **Next**.

5. In the **Choose Installation Type** window, choose the option you want to install. The Custom and Network options are described in more detail in Installation Options on page 12.
   - Select **Express** to let install make the best install choices based on your existing QuickBooks application and network configurations.
   - Select **Custom and Network** options to customize the network installation and location.

To install the Database Server on a Linux file server, refer to the QuickBooks Enterprise Solutions Linux Database Server Manager Installation and Configuration Guide.

6. Follow the onscreen instructions until installation is complete.
   - If you receive an error message during installation and rebooting your system does not resolve the problem, go to the QuickBooks support site at [www.quickbooks.com/installation](http://www.quickbooks.com/installation) to find solutions to common errors.

7. If you are upgrading from another version of QuickBooks (Pro, Premier, or Enterprise Solutions), the File Management tool opens and instructs you to move your company files or perform additional installation modifications. Follow the onscreen instructions.

8. If you installed on a server, launch the QuickBooks Database Server Manager so that you can configure the database server. Refer to Configuring Database Server Manager on page 23.
Configuring Database Server Manager

The QuickBooks Database Server Manager ensures that your Enterprise Solutions users can access the company files stored on your server. After you complete server installation, you must configure the QuickBooks Database Server Manager.

If the QuickBooks Database Server Manager does not open automatically after installation, go to the Start button, click Programs, click QuickBooks, and then click QuickBooks Database Server Manager.

![The QuickBooks Database Server Manager](image)

To configure the Database Server Manager, you need to:

- Scan your company files. Refer to Scanning Company Files on page 24.
You must have QuickBooks Administrator privileges to configure the Database Server Manager.

From the Database Server Manager you can also check the status of the QuickBooks Database Server service (QuickBooksDB20), and see which users are currently accessing the company files. You can also check for recent updates to the Database Server Manager software. Refer to the in-product Help for more information.

**Scanning Company Files**

All company files stored on the server must be scanned once to ensure that they are configured properly to allow access to other QuickBooks users.

- **To scan the company files:**
  1. Click the **Scan Folders** tab.
  2. Click the **Add Folder** button to browse the server for the folders that contain the company files.
     
     The folders display in the **Folders that contain company files** box.
     
     **Note:** If you are not sure where the company files are stored, you can choose to scan entire disks.
  3. Click the **Scan** button to start the scanning process.
     
     When the scan is complete, the **QuickBooks company files found** box displays all the company files found.
Monitoring Your Hard Drives

The Database Server Manager monitors the selected drives to ensure that other computers can open the company files that are copied or moved to this server.

To monitor the computer drives:

1. Click the Monitored Drives tab.
2. Click to select all local drives that you want to monitor for company files that are added, removed, or renamed.

   Note: Mapped drives are not displayed and cannot be monitored.

Providing Access to Company Files

Share the folder that contains your QuickBooks company files across your network. Make sure that all users have read/write access and create/delete rights to the directory where the company files are stored. Refer to the documentation for your operating system to learn about sharing folders and providing read/write access.
Registering Your Enterprise Solutions Software

After you install Enterprise Solutions, you must register your software. Registration entitles you to many benefits including access to technical support and the ability to use online features.

Register Enterprise Solutions on every computer on which you have installed the Enterprise Solutions application. You do not need to register Enterprise Solutions on your file server that contains the Database Server only.

*Note* You can use Enterprise Solutions for 30 days without registering. After 30 days, you must register.

- **To register Enterprise Solutions:**
  1. Start Enterprise Solutions.
  2. The Register QuickBooks Enterprise Solutions 10.0 window opens automatically. If the window does not open, go to the Help menu and click Register QuickBooks.
  3. Click the Begin Registration button and follow the onscreen instructions.

If you prefer, you can register Enterprise Solutions by phone. The toll-free registration line is available from 5:00 a.m. to 6:00 p.m. (Pacific Standard Time) seven days a week.

*Note* If you move your installation from one computer to another, you need to re-register Enterprise Solutions on the new computer.
Installing Additional Software

Enterprise Solutions is compatible with the products listed in Table 4 as well as many others. These products, which are each sold separately, provide additional functionality. See www.marketplace.intuit.com for the most up-to-date list of products.

<table>
<thead>
<tr>
<th>Product</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Word 2000, 2002, 2003, or 2007</td>
<td>To use features that integrate with Microsoft® Word (such as prepare letters)</td>
</tr>
<tr>
<td>Microsoft® Excel 2000, 2002, 2003, or 2007</td>
<td>To use features that integrate with Microsoft® Excel (such as export reports)</td>
</tr>
<tr>
<td>Microsoft® Outlook 2000, 2002, 2003, or 2007</td>
<td>To synchronize with contact management software</td>
</tr>
<tr>
<td>Adobe Acrobat 5.0 and later</td>
<td>To use Business Planner functionality</td>
</tr>
<tr>
<td>Internet access with at least a 56 Kbps connection speed (DSL or cable modem recommended)</td>
<td>To use QuickBooks Payroll subscriptions and online features/services</td>
</tr>
<tr>
<td>QuickBooks Point-of-Sale 6.0 and later</td>
<td>To save book keeping time</td>
</tr>
</tbody>
</table>

Table 5  Enterprise Solutions Compatible Products

Install the software according to the instructions provided with the software.
This chapter describes the configuration tasks you need to perform after you have installed the QuickBooks Enterprise Solutions Financial Software.

Perform the following configuration tasks on your server (the computer on which you store the company files). If you installed the Database Server only on a file server, perform the following tasks on one of your client computers.

To perform these tasks, you must have QuickBooks administrator privileges.

Creating a Company File

The company file is the data file that Enterprise Solutions uses to store and manage all the information and financial transactions for your business. Company files have a file extension of .qbw.

Depending on the complexity of your business, setting up your company file can take anywhere from a few minutes to a few hours. The amount of time varies based on how much detail you add about your accounts, customers, vendors, employees, products, and services, as well as the number of historical transactions you want to enter.

When you set up your company file, Enterprise Solutions prompts you for a number of details about your company. Before you begin the setup...
This chapter describes the configuration tasks you need to perform after you have installed the QuickBooks Enterprise Solutions Financial Software.

Perform the following configuration tasks on your server (the computer on which you store the company files). If you installed the Database Server only on a file server, perform the following tasks on one of your client computers.

*Important* To perform these tasks, you must have QuickBooks administrator privileges.

---

### Creating a Company File

The company file is the data file that Enterprise Solutions uses to store and manage all the information and financial transactions for your business. Company files have a file extension of `.qbw`.

Depending on the complexity of your business, setting up your company file can take anywhere from a few minutes to a few hours. The amount of time varies based on how much detail you add about your accounts, customers, vendors, employees, products, and services, as well as the number of historical transactions you want to enter.

When you set up your company file, Enterprise Solutions prompts you for a number of details about your company. Before you begin the setup
process, gather the information listed in the Company File Checklist in Table 5, below.

<table>
<thead>
<tr>
<th>Company File Checklist</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Company Name and Address</strong></td>
<td>You need both the legal and casual name for your company.</td>
</tr>
<tr>
<td></td>
<td>• The legal company name is the name you use when filing the taxes for your business.</td>
</tr>
<tr>
<td></td>
<td>• The casual company name is the name that you want to appear on invoices, statements, reports, and so on. (This is your Doing Business As name.)</td>
</tr>
<tr>
<td><strong>Federal Tax ID Number</strong></td>
<td>The nine-digit number issued to you by the IRS. The Federal Tax ID number is also called an EIN (Employer Identification Number). If you do not have an EIN, you can either obtain one by submitting Form SS-4 (call 1-800-TAX-FORM to get this form), or you can use your Social Security number (if you are a sole proprietorship and you do not pay wages to employees or file pension and excise tax returns).</td>
</tr>
<tr>
<td><strong>Sales Tax Information</strong></td>
<td>If you charge sales tax, you need to know the sales tax rate you charge, how much sales tax you owe as of your start date, and the name and address of the agency (for example, California Franchise Tax Board) to which you pay your sales tax.</td>
</tr>
<tr>
<td><strong>Administrator Password</strong></td>
<td>You need to assign one user to be the Administrator who defines access for all other users. Intuit strongly recommends that you password-protect the Administrator user; otherwise, anyone who can access the company file will have full access rights to your company’s financial data.</td>
</tr>
</tbody>
</table>
### Company File Checklist

| Start Date | Enterprise Solutions uses a start date as the point at which you begin entering your business transactions. You must enter all historical transactions between your start date and today to ensure complete accounting records for your business. Many business owners base their accounting records on their fiscal year so that they can see transactions for the entire year. If this is not important to you, you can choose a different starting point, such as today or the first of the month, quarter, or year. |
| Bank Statements, Credit Card Accounts, and Outstanding Checks | You need the most recent bank statement for one of your bank accounts with a closing date that is before your start date. The closing balance on this statement is your opening balance for the bank account you create in Enterprise Solutions, and then you enter all the open transactions and all the new transactions from the start date forward. Eventually, you will need to have your latest bank statement balances and any outstanding checks, deposits, withdrawals, or charges for all of the accounts you want to set up and manage, including credit cards, bank accounts, lines of credit, and loans. |
| Optional Information | Eventually, you will need to enter detailed information about your customers, vendors, and employees, as well as the products and services you sell, the products that you hold in inventory, and any additional assets. |
Company File Checklist

| Payroll | If you are using Payroll, gather the following information from your employees: company information; rate of pay, benefits, and miscellaneous additions and deductions; withholdings; tax information; employee information; year-to-date history; liability payment information; and direct deposit information. |

Table 5 Company File Checklist

After you have gathered the company information listed in the previous table, you can set up your business using the EasyStep Interview. The EasyStep Interview walks you through the setup procedure and helps you tailor Enterprise Solutions for your business. The setup interview is divided into sections, so you can save your progress and return at a later time.

Note In some industry-specific editions of Enterprise Solutions (for example, Contractor Edition), you can choose to use a predefined company file as the starting point for setting up your business. The predefined company file provides a tailored chart of accounts, an item list of products and services that you might provide, and custom reports applicable to your business. Even though using a predefined company file gets you up and running quickly, you still need to enter the information specific to your business.
To create your company file:

1. Start Enterprise Solutions by double-clicking the Enterprise Solutions icon on the desktop.

2. Click Create a new company file or go to the File menu and click New Company.

3. The Welcome window for the EasyStep Interview opens. Click Start Interview.
   
   **Note:** Intuit recommends that you do not skip the interview process. The more information you enter in the EasyStep Interview, the more accurate your company file will be when you begin to use Enterprise Solutions for your business.

   However, if you are an experienced user and prefer to create your company file manually, you can skip the EasyStep Interview by clicking Skip Interview on the EasyStep Interview Welcome window. You will be prompted to enter some basic company information and to save the company file.

4. Follow the onscreen instructions to complete the interview.

   **Tip:** During the EasyStep Interview, you can choose to leave the interview and finish later. This is sometimes necessary, if you do not have all the information available to complete the interview or if you have other time-sensitive tasks you need to do. You can click Leave at any time to exit the EasyStep Interview. When you return to Enterprise Solutions, the EasyStep Interview reopens automatically. If it does not, go to the File menu and click Open Company. Choose the company file you were creating from the list. The EasyStep Interview opens in the same window that you left. If you leave the interview before the company file is saved to disk, you must restart the EasyStep Interview.
Completing Your Company File Setup

After you have created your company file, you can begin using Enterprise Solutions to run your business. But before you do, Intuit recommends that you review the information in this section to make sure your company file is properly set up and that your data is complete.

This section describes some additional tasks you might need to do as you begin using Enterprise Solutions. Depending on how much information you entered during the EasyStep Interview, some of these tasks might not apply to you.

Enter Your Company Information

Do this task if you did not enter this information in the EasyStep Interview.

To enter the contact and legal information for your company, go to the Company menu and click Company Information. To learn more about each of the fields and where the information you enter is used, click the Help button.

Review Your Chart of Accounts

If you used the EasyStep Interview, a chart of accounts based on your type of business was set up for you. Review the chart of accounts to be sure it accurately reflects the accounts you need to run your business. You can change account names and edit, delete, or add accounts as necessary. For example, you will need to add any personal bank, credit card, or loan accounts.

To view your Chart of Accounts, go to the Lists menu and click Chart of Accounts.
Number Your Accounts

Some businesses prefer to organize their accounts by number. Adding numbers can help you identify the type of accounts, thereby speeding up your account selection on various forms. You might want to develop and follow a consistent account naming and numbering convention. For example:

- 10000-19999 - Assets
- 20000-29999 - Liabilities
- 30000-39999 - Equity
- 40000-49999 - Income
- 50000-59999 - Cost of Goods Sold
- 60000-69999 - Expenses (or Operating Expenses)
- 70000-79999 - Other Income (not related to daily activity)
- 80000-89999 - Other Expenses (not related to daily activity)

If you want to use numbers to identify your accounts, you need to turn on this preference in Enterprise Solutions.

To turn on account numbering:

1. Go to the Edit menu and click Preferences.
2. In the Preferences window, click Accounting in the list on the left.
3. Click Company Preferences.
4. Select the Use account numbers checkbox.
5. Click OK.

Create Your Customer, Vendor, and Item Lists

To bill customers and pay your bills, you must update your customer, vendor, and item lists so that they accurately reflect your business. Refer to the in-product Help.
Enter Historical Transactions

If your start date is before today’s date, you need to enter past transactions from the start date to today. This ensures that your records are completely up-to-date and reports are accurate.

Enter historical transactions in chronological order. For example, Enterprise Solutions does not know how to credit a customer payment unless you previously recorded the invoice to that customer.

*Note* Entering historical transactions is especially important if customers do not pay you at the time they receive goods or services. Without these historical transactions, it is hard to track and collect late customer payments.

Intuit recommends that you enter your transactions in this order:

- Invoices or statements you have sent out since your start date
- Purchase orders you have issued since your start date that you have not received in full
- Cash or checks you have received since your start date
- Bills you have received since your start date
- Bills you have paid since your start date
- Deposits you have made to any of your accounts since your start date
- Any other checks you have written (for things other than bills) since your start date
- Employee year-to-date information accrued from January 1 through your start date
- Payroll liabilities owed at the time of your start date (for manual payroll and tracking payroll transactions only)

*Note* If you do not have time to enter all your historical transactions right away, do not worry. You do not need to enter all your past transactions before you start using Enterprise Solutions for new transactions. Enter new transactions as they occur. Then catch up with historical transactions when you can. Remember, though, that your account balances will be incorrect (and your reports may be wrong) until you enter all the past transactions.
If you subscribe to a QuickBooks payroll service, you are prompted to add year-to-date payroll information during payroll setup. If you do not provide this information, your payroll tax information may not be accurate.

**Complete Your Bank Account Information**

After you enter your historical transactions, your account registers contain entries reflecting bills you have paid, checks and paychecks you have written, and deposits you have received. To make your account registers complete, you must also enter these transactions:

- Checks or other charges that happened before your start date but did not appear on statements before your start date (for example, a check that did not clear)
- Other checks you wrote after your start date that were not for bills or accounts payable (for example, credit card payments)
- Deposits you made after your start date that were not customer deposits
- Deposits you made before your start date but that did not appear on statements before your start date
- Bank charges and fees
- Interest paid on your account

Refer to the in-product Help for step-by-step instructions on how to enter these transactions to make your account registers accurate.

**Synchronize with Microsoft Outlook**

If you use Microsoft Outlook, you can synchronize your contact manager with Enterprise Solutions and transfer all your customer and vendor information (including address and phone) to Enterprise Solutions.

Intuit recommends that you synchronize your customer and vendor information before you enter any customers or vendors manually.
To synchronize your customer and/or vendor information:

1. Go to the **Company** menu, click **Utilities**, and then click **Synchronize Contacts**.

   **Note:** If you are synchronizing for the first time, Intuit recommends that you back up both the data in your contact manager and your company file before you synchronize.

   **Note:** If you do not have the QuickBooks Contact Synchronization tool installed on your computer, you are prompted to download and install it.

2. Follow the onscreen instructions. You might be asked to resolve conflicts between your Enterprise Solutions and contact manager data, assign uncategorized names to lists, or create alternative entries for duplicate names. If you need assistance with any of these tasks, click **Help**.

3. When the **Confirm Changes** window appears, review the list of changes and click **Accept** to apply the changes.

**Enter Any Optional Adjustments**

After you have created your company file, you might need to make a few adjustments as of your start date. Depending on your company, you might need to:

- Enter any sales tax liabilities
- Adjust the Uncategorized Income and Uncategorized Expense accounts (for accrual basis only)
- Adjust for current income and expenses if your start date is not at the beginning of the fiscal year

Refer to the in-product Help for step-by-step instructions on how to enter these optional adjustments. If you are unsure whether you need to enter these optional adjustments, check with your accountant.
Updating Your Company File

This section describes how to update a company file created in a previous version of QuickBooks Enterprise Solutions, Pro, or Premier. Before you can update your company data, you must install the new version of Enterprise Solutions as described in Installing Enterprise Solutions on page 21.

You cannot create a new company file and then import your company data from a prior version of QuickBooks Enterprise Solutions, Pro, or Premier. Use this procedure to update your company file.

Caution

After you update an existing company file to QuickBooks Enterprise Solutions 10.0, you cannot read or use the file with older versions of QuickBooks Enterprise Solutions, Pro, or Premier.

To update your Company File:

1. Prior to installing QuickBooks Enterprise Solutions 10, you should use your current version of Enterprise Solutions to create a backup copy of your company file using the Save copy or Backup command in the File menu.

2. Install Enterprise Solutions 10 as described in chapter 3.

3. In QuickBooks Enterprise Solutions 10.0, open your company file (the company file you used with your previous version of QuickBooks).

4. If the Move Company File utility opens, Intuit recommends that you move the company file from the Program Files folder to the recommended location.

Note

The Windows Program Files folder is no longer a recommended location for storing company files.

5. If prompted, enter the Administrator password.

6. When prompted, select the I understand that my company file will be updated to this new version of QuickBooks checkbox and then click Update Now.

7. When prompted to back up your data, click OK.

8. In the Save Copy or Backup window, follow the onscreen instructions to back up your company file.

   Important: Do not overwrite existing backups.

9. When prompted to confirm that you want to update your file, click Yes.
Adding and Setting Up Users

Passwords limit access to your company files. To open a password-protected file, each person must enter a user name and a unique case-sensitive password. Defining users and passwords helps prevent unwanted people from accessing your company’s confidential data.

Important

Intuit strongly recommends that you password-protect the Administrator user. Otherwise, anyone who can access the company file will have full access rights. Write down and save your Administrator password in a secure place. Passwords not only protect your company data but are also required to access your company file if you upgrade your version of Enterprise Solutions.

Enterprise Solutions lets you apply user permissions to different activities by assigning distinct user-access levels including view-only, create, modify, delete, and print. You can also restrict access to specific lists and report groups based on user roles.

Enterprise Solutions comes with fourteen predefined roles. These are roles with preset access to areas and activities based on the functions most commonly found in a business. Examples include Accounts Receivable, Accounts Payable, Banking, Sales, and Payroll Manager. You can use any of the pre-defined roles and customize them to suit your needs, use them as-is, or create your own. All users must be assigned a role.

To add and set up Enterprise Solutions users:

1. Start Enterprise Solutions.
2. Go to the Company menu, click Users and then click Set Up Users and Roles.
3. Click the Role List tab and then click the New button.
4. Enter the name of the role in the Role Name field or select an existing role.
5. Assign access levels to the activities and click OK.
6. Click the User List tab and then click the New button.
7. Enter the name of the user in the User Name field.
8. Enter a password in the Password field, and again in the Confirm Password field.

9. Assign roles to this user and then click OK.

---

Setting Up Multi-User Hosting

The server must be the only host for the company files. The server serves data to other computers (clients) on the network.

Verify that only the server has multi-user hosting enabled. All clients must have multi-user hosting disabled.

**Note**
If you installed the Database Server only on a file server, you do not need to enable multi-user hosting on the server. However, you must make sure that all clients have multi-user hosting disabled.

- **To verify that multi-user hosting is enabled on the server:**
  1. Start Enterprise Solutions on the server (the computer where the company files are located).
  2. Go to the File menu and click Utilities.
  3. Verify that Stop Hosting Multi-User Access is displayed in the Utilities menu.

     If Host Multi-User Access is displayed in the Utilities menu, the computer is not currently the host for the company files. Follow the steps below.

     a. Click Host Multi-User Access.
     b. Click Yes when prompted to start multi-user access.
     c. Click Yes when prompted to close and reopen the company file.

To make sure that your clients have multi-user hosting turned off, follow the procedure above on each client. Host Multi-User Access must be displayed in the Utilities menu on each client.
Converting Data from Other Applications

You can convert financial data from the following applications into Enterprise Solutions:

- Quicken
- QuickBooks Online
- QuickPayroll (additional fees apply)
- Excel
- Peachtree
- Microsoft Office Accounting (version 2001 through 2008)
- Microsoft Small Business Accounting

Detailed instructions about data preparation and conversion into Enterprise Solutions are provided in the in-product Help: Go to the Help menu and click QuickBooks Help.

To convert applications not listed above, contact Technical Support at www.qbes.com/support.
Updating Your Enterprise Solutions Software

Periodically, Intuit provides updates to Enterprise Solutions that can be downloaded from the Internet. These updates might include a maintenance release (also known as a patch), a new feature, a new service, or timely information that could be relevant to your business.

You can choose to update Enterprise Solutions automatically or manually. Enterprise Solutions is initially configured to download updates from the Intuit server to your computer automatically. It periodically checks for new updates and downloads them when your Internet connection is not being used by another process or application.

Intuit recommends that you leave automatic update enabled on your Enterprise Solutions computers.

For a complete description of the different update options, refer to the in-product Help.
Troubleshooting

This section lists common problems that you may encounter during installation and configuration, and describes how you should proceed.

If you have trouble installing Enterprise Solutions:

1. Verify that your system meets the minimum requirements listed on page 15.
2. Restart your computer.
3. Close all open programs, including virus protection programs: Go to the Windows Task Manager (Task List), click the Applications tab, and close all open programs.
4. Try installing Enterprise Solutions again.
5. If you need further installation assistance, visit www.quickbooks.com/installation.

If you cannot find your Registration Number:

Enterprise Solutions no longer uses registration numbers. The only numbers you need are your Product and License numbers found on a sticker with your CD or by clicking Manage My License from the Help menu.

If you purchased Enterprise Solutions online and downloaded the software (that is, if you don't have the Enterprise Solutions CD), the Product and License numbers are included in your confirmation e-mail.
Troubleshooting

This section lists common problems that you may encounter during installation and configuration, and describes how you should proceed.

If you have trouble installing Enterprise Solutions:

1. Verify that your system meets the minimum requirements listed on page 15.
2. Restart your computer.
3. Close all open programs, including virus protection programs: Go to the Windows Task Manager (Task List), click the Applications tab, and close all open programs.
4. Try installing Enterprise Solutions again.
5. If you need further installation assistance, visit www.quickbooks.com/installation.

If you cannot find your Registration Number:

Enterprise Solutions no longer uses registration numbers. The only numbers you need are your Product and License numbers found on a sticker with your CD or by clicking Manage My License from the Help menu.

Note

If you purchased Enterprise Solutions online and downloaded the software (that is, if you don’t have the Enterprise Solutions CD), the Product and License numbers are included in your confirmation e-mail.
If you cannot find your License Number or Product Number:

Look for the sticker on your Enterprise Solutions CD folder. If you cannot find the CD folder but have Enterprise Solutions installed on another computer, you can find your License Number and Product Number as follows:

1. Open QuickBooks on another computer.
2. Press the F2 key or Ctrl + 1 to open the Product Information screen. Write down the License and Product numbers.
3. Click OK.

If you are still unable to obtain your License Number and Product Number, you can request new numbers online:

1. In your Internet browser window, enter the URL support.quickbooks.intuit.com/support/LicenseNumber
2. Complete the onscreen request form.

If old administrator password does not work after upgrading:

QuickBooks 2004 and later releases support case-sensitive passwords. If you believe you are entering the correct password but still get the message The password you typed is incorrect, your password might include mixed-cased characters. Try the following solutions:

- Enter the login name Admin and then click OK without typing a password.
- Enter your password with Caps Lock or Num Lock turned on or off.
- Enter variations of your password, using mixed upper- and lowercase characters.
- Enter the password with a space before or after the actual password.
- Type the password in a text editor such as WordPad or NotePad to confirm that your keyboard is functioning properly.
Troubleshooting and FAQs

- Restore a pre-update backup of your file that does not have the case-sensitive password. When you restore this file, you can set your new administrator password at the end of the update process.

If you are still unable to access your file, go to the Password Recovery website: www.qbes.com/passwordremoval (additional fees may apply).

**Note**

Be sure to write down and save your administrator password in a secure place. Passwords not only protect your company data, but are also required to access your company file if you upgrade your version of Enterprise Solutions.

**If a problem occurs when updating your company file:**

If you attempted to update your company file and the update failed, you must perform steps in your older version of QuickBooks to fix the problem. If you removed your older version of QuickBooks, reinstall it to a new directory.

**Caution**

Do not install the older version in the directory where you installed Enterprise Solutions 10.0.

- **To fix a failed company file update:**

  1. Start the older version of QuickBooks Enterprise Solutions, Premier, or Pro and perform step 2 through step 5 using the older version.

  2. Restore your company backup using the older version of QuickBooks Enterprise Solutions, Pro, or Premier. Go to the **File** menu, click **Open or Restore Company**, and then follow the onscreen instructions.

  3. Go to the **Window** menu and click **Close All**.

  4. Go to the **File** menu, click **Utilities**, and then click **Rebuild Data**.

    **Caution:** The Rebuild Utility forces you to create another backup. Use a new CD or file name. Do not overwrite any existing backups.
5. After the Rebuild is complete (this may take a long time depending on the size of your company file), exit from the older version of QuickBooks.

6. If you reinstalled your older version of QuickBooks Enterprise Solutions, Premier, or Pro over your Enterprise Solutions installation, you must reinstall Enterprise Solutions 10.0 software (described on page 21) before proceeding to the next step.

7. Start Enterprise Solutions 10.0.

8. Go to the File menu and click Open or Restore Company.

9. Click Open a Company File.

10. Select the appropriate directory and file name of the company data you just rebuilt and click OK.

If you still experience update problems, visit Technical Support at www.qbes.com/support.

If you do not have Internet Explorer on your computer:

To use Enterprise Solutions, you must have Microsoft Internet Explorer 6.0 or later installed on your computer. If you do not have any version of Microsoft Internet Explorer on your system, you can download the latest version from www.microsoft.com.

Note: Installing the latest version of Microsoft Internet Explorer does not affect the settings or preferences of other browsers on your system.
Frequently Asked Questions
This section lists frequently asked questions and provides helpful tips.

How do I contact Technical Support?

How do I purchase additional user licenses?
Enterprise Solutions allows multiple users to access the company file at the same time. As your company grows, you can add additional licenses instead of purchasing additional copies of Enterprise Solutions.
Enterprise Solutions licenses can be added in increments of five. To add additional licenses to your existing Enterprise Solutions license, go to the Help menu, click Manage My License, click Buy Additional User Licenses, and then follow the onscreen instructions.

How do I download and install an update or patch?
Periodically, Intuit provides updates to Enterprise Solutions that you can download from the Internet. These updates can include a maintenance release (also known as a patch), a new feature, a new service, or timely information that could be relevant to your business.
To download an update, go to the Help menu and click Update QuickBooks. Follow the onscreen instructions.
How do I move my company file from one computer to another?

To move company files from one computer to another, Intuit recommends that you use a portable company file. The portable company file does not simply copy the data for your company; it compresses the data into a smaller file.

To move your company file:

1. Create a portable company file on the source computer:
   a. Go to the File menu and click Save Copy or Backup.
   b. Click Portable Company File and then click Next.
   c. Select the drive (hard drive, CD, ZIP, or flash drive) where you want to save the portable company file. You can use the same filename or enter a new name.
   d. Click Save.

   Note: Disconnect your flash or USB connected drive by using the Safely Remove Hardware option in Windows.

2. Take the media containing your portable company file to the computer to which you want to move your company file.

3. Open the portable company file on the destination computer:
   a. Go to the File menu and click Open or Restore Company.
   b. Click Restore a portable file and click Next.
   c. In the upper section of the window, select the location and filename of the portable company file.
   d. In the lower section, change the location and filename of the company file that will be created and opened from the portable company file. If you select an existing company file, it will be overwritten with the data from the portable company file.
   e. Click Open.
How do I back up or restore my company file?

You should back up your company files daily. Backup copies are important insurance; if you lose data for any reason, you can restore data from your backup copy. Enterprise Solutions enables you to back up and restore your data in a number of ways.

To backup a company file:

1. Go to the File menu and click Save Copy or Backup.
2. Choose the backup option you want, click Next, and follow the onscreen instructions.

To restore a company file:

1. Go to the File menu and click Open or Restore Company.
2. Choose the restore option you want, click Next, and follow the onscreen instructions.

To view detailed instructions for each backup and restore option, refer to the in-product Help.

Can I install different versions of Enterprise Solutions?

You can install multiple versions of Enterprise Solutions (for example, Enterprise Solutions 10.0 and Enterprise Solutions 9.0) on the same computer. However, you cannot run two instances of the same version of Enterprise Solutions on the same computer at the same time.

How do I revert to an earlier version of Enterprise Solutions?

Uninstall the version of Enterprise Solutions that you do not want and then reinstall the earlier version of Enterprise Solutions. Remember that you cannot open a company file that you converted to Enterprise Solutions 10.0 in earlier versions of QuickBooks Enterprise Solutions, Premier, or Pro. However, you can restore your pre-update backup if you choose to go back to a prior version of Enterprise Solutions.
How do I install an Enterprise Solutions upgrade CD?

When you insert the upgrade CD into the CD-ROM drive, the setup program tries to detect an earlier installed version of QuickBooks Enterprise Solutions, Premier, or Pro on your computer. If it cannot find the older version on your hard drive, you will be prompted to insert the CD or the installation disk from the older version into the appropriate drive during product registration. If you do not have your older QuickBooks Enterprise Solutions, Premier, or Pro media, you will be sent to a Web form to enter the required product information.
Index

Symbols
.qbw file 18, 29

A
Administrator password 30
Antivirus compatibility 16

C
Chart of Accounts 34
Client installation option 12
Company file
  backing up 51
  checklist 30
  completing setup 34
  creating 29
  extension 29
  moving 50
  restoring 51
  sales tax rate 30
  updating problem 47
Company name
  casual 30
  legal 30
Compatibility
  antivirus 16
  firewall 16
Configurations 11

D
Database Server Manager 23
Database Server Only install 12
Disk Space 15

Downloading upgrades 49

E
EasyStep Interview 33
EIN 30
Excel 42

F
Firewall compatibility 16
Firewall software 16

H
Historical transactions 36

I
Improving performance 19
Installation
  options 12
  problems 45
  procedure 21
Internet Explorer 48

L
License number 46
Linux server 14, 16

M
McAfee AntiVirus 16
Microsoft Office Accounting 42
Microsoft Small Business Accounting 42
Monitor 15
Multi-User hosting 41